
 

 

 



ii  QRG102NA5101 

Contents 

Getting Started with Executive Insight .......................................................................................................... 2 

Start up Executive Insight ............................................................................................................................. 2 

The Executive Insight Interface ...................................................................................................................... 2 

Toolbars ............................................................................................................................................................ 3 

Show or hide Toolbars .................................................................................................................................. 3 

Phone Toolbar .............................................................................................................................................. 3 

Speed Toolbar .............................................................................................................................................. 3 

Voice Messaging Toolbar ............................................................................................................................. 4 

Phonebook Functions ..................................................................................................................................... 4 

Access the Phonebook ................................................................................................................................. 4 

Search for a Contact ..................................................................................................................................... 4 

Add a new Contact ....................................................................................................................................... 4 

Edit Contact Details ...................................................................................................................................... 5 

Delete Contact Details .................................................................................................................................. 5 

Presence Functions and Buttons................................................................................................................... 5 

Presence Buttons ......................................................................................................................................... 5 

Presence Button Symbols ............................................................................................................................ 6 

Set Presence Profile ..................................................................................................................................... 7 

Set ETR ........................................................................................................................................................ 7 

Presence Status ........................................................................................................................................... 8 

Add a Presence Note.................................................................................................................................... 8 

Add a New Presence Page - Wizard ............................................................................................................ 8 

Rename a Presence Page ........................................................................................................................... 8 

Delete a Presence Page ............................................................................................................................... 9 

Add a Presence Button ................................................................................................................................. 9 

Delete a Presence Button ............................................................................................................................. 9 

Managing Calls................................................................................................................................................. 9 

Make a Call ................................................................................................................................................... 9 

Answer a Call ................................................................................................................................................ 9 

Phone Calls Pane – Active call functions ................................................................................................... 10 

Transfer a Call using the Phonebook ......................................................................................................... 10 

Managing Voice Messages ........................................................................................................................... 10 

Play a Voice Message ................................................................................................................................ 10 

Forward a Voice Message .......................................................................................................................... 11 

Delete a Voice Message ............................................................................................................................. 11 

Desk to Desk Chat ......................................................................................................................................... 11 

Chat Toolbar buttons and Controls ............................................................................................................. 11 

Make a Chat Call ........................................................................................................................................ 12 

End a Chat Call ........................................................................................................................................... 12 



QRG102NA5101  iii 

Answer a Chat Call ..................................................................................................................................... 12 

Transfer a Chat Call .................................................................................................................................... 12 

Invite Additional Chat Participants .............................................................................................................. 12 

Private Chat ................................................................................................................................................ 13 

Chat Messages ........................................................................................................................................... 13 

Create and Use Templates ......................................................................................................................... 13 

Additional Chat Functions ........................................................................................................................... 13 



 Executive Insight User Quick Reference Guide 

QRG102NA5101 2 

Executive Insight does not start automatically when you start Outlook. Click on the  button at 
the top of the display to start Executive Insight. 

You can set an option to automatically start Executive Insight. Open the Tools>Phone menu and check 
the Load on Start option. Executive Insight will now start automatically when Outlook is started. 

Executive Insight creates a folder in the Outlook mail folders named Phone. You can return to the 
Executive Insight view at any time by opening this folder, or by clicking your extension in the menu bar. 

The first time you start Executive Insight you may be prompted to complete some initial setup using the 
Setup wizard. 
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1. Select Toolbars from the View menu and check/uncheck the items to display/hide the toolbars. 

 
Toolbar options change dynamically based on 
current activity.  

 

 

 
Answer a call (only appears when a call is presenting) 

 
Dial a contact 

 
Hang up a call (Normally grayed out; button is available when you are on a call) 

 
Hold/Unhold a call 

 
Park/Unpark a call 

 
Forward all calls/Cancel Forward 

 
Destination Cancel - Cancel Transfer 

 
Complete Transfer 

Speed Buttons for frequently used Phonebook contacts can be placed on a Speed Toolbar to provide 
quick dialling and a visual indication of an internal user’s Presence status. 

 

Add a Speed Button: 

1. Click Customize on the Speed Toolbar. 

2. Select Add Speed button and using the Phonebook select the contact name and click Add Button. 

Making a Call using the Speed Buttons: 

1. Click on the Speed Button of the party that you wish to call and click on the phone number or 

extension that you wish to dial. 

Transferring a Call using the Speed Buttons: 

1. Whilst on a call, click the Speed Button of the party that you wish to transfer the call to and then 

click on the phone number or extension that you wish to transfer the call to. 

View a User’s Availability: 

1. Hover the mouse pointer over a Speed Button to view Presence status 
and their ETR, if set. 
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Request Availability Notification: 

1. Click on the Speed Button and select: 

 Notify Me when [Name] is back: Use when the extension is forwarded. 

 Notify Me when [Name] is off the Phone: Use when the extension is busy. 

2. You will receive a popup notification message. 

 

 View or change the current active Presence profile. 

 Click to access your Mailbox setup. 

 
View your mailbox status. 
Click the Mailbox button to automatically call Voice Messaging 

 Redirect an incoming call to Voice Messaging as a fax. 

 

The mailbox button displays the mailbox status, using one of four icons: 

 No messages 

 1 or more ordinary messages 

 Caller currently recording message. 

 
1 or more urgent messages. 

To open the Phonebook click  on the telephone toolbar, then click  to open the Phonebook. 

1. Type the contact’s name in the Look for field. As you type the list of 
matches will be refined. 

2. Optionally refine your search by selecting a specific search 
directory. 

3. Select the contact’s name in the Found Contact pane to display 
the associated contact numbers. 

1. Select the appropriate directory from the drop-down list. 

2. Click the  symbol above the Found Contacts pane. 

3. Enter the contact details in the New Contact window and click OK. 

4. Select the new contact in the Found Contacts list. 
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5. Click the  symbol above the Numbers/Addresses pane. 

6. Choose a number type from the drop-down menu. Populate the required details such as country 
code, area code and number. The number must contain a country code, area code and the actual 
number; otherwise it can not be dialled from the Desktop Application. 
 
Note: (New Zealand only) Area Code does not require the leading "0" (zero). 

7. Click OK to store the information.  Repeat steps 5 and 6 to add additional contact numbers. 

1. Select either the contact name or the contact number. 

2. Click the  icon above the pane or select Properties from the right-click menu to edit the 
information. 

3. Update information as required and click OK to save. 

1. Select either the contact name or the contact number. 

2. Click the – icon or select Delete from the right-click menu to delete the information. 

3. Click Yes when prompted to confirm the deletion. 

Presence buttons provide real-time visual 
information on the whereabouts and 
availability of staff. If they are out of the office 
or in a meeting you can see when they will be 
back and if they are away from their desk or 
on a call you can request an automatic 
notification when they are available again. 
Presence buttons can also be used to initiate 
a call to that person. Presence buttons can 
be grouped and arranged on separate pages. 

There are two types of Presence buttons: 

 External (telephone numbers outside your office) 

 

 Internal (in-house extension numbers) 

 

Internal Presence buttons enable you to view the user’s extension status by viewing icons and the status 
tool tip. You can also perform advanced call functions for an extension using the right-click popup menu. 
The user’s name displays in mustard text if they are logged into queues as an agent. 

Left click - more numbers 

Click the phone status icon to display additional contact numbers. Click the 
number you wish to call. 
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Right click - other functions 

Right-click on the Presence button to display the pop-
up menu. 

 

Note: The actual options available will depend on the 
type of PBX being used, how the system is setup and 
your enabled security permissions. Certain options will 
also only be visible when there is an active call on your 
extension. 

 

 Call ‘user’ on extension Initiate a call to the user on the designated telephone number. 

 
Supervised Transfer 
to ‘user’ 

Transfers your Active Call to the user’s extension and enables 
you to talk to the user before completing the transfer. 

 
Blind Transfer to ‘user’ Transfers your Active Call to the user’s extension. 

 
Transfer Call Transfers your Active Call to the user’s extension. 

 Park for ‘user’ 
Holds the Active Call at your extension; you can then retrieve the 
call. 

 Advanced Park Parks your Active Call and pages the user. 

 
Notify me when  
user’ is back 

A screen-pop will inform you when the user is in the office and 
available to take your call. 

 Forward all Calls Forwards all your calls to a specified internal or external number. 

 
Leave a Voice Message Record a Voice Message for the recipient. 

 Ask ‘user’ to call me back The user will receive a pop-up call-back request on their return. 

 
Transfer to Mailbox Transfers your Active Call to the user’s Voicemail mailbox. 

 
Record Conversation 
to Mailbox 

The conversation is saved to the current user’s mailbox (if 
installed). 

 
Send Message to  
digital Phone 

Send a short text message to the LCD screen of the user’s digital 
phone. 

 Select Presence Profile Change the user’s Presence profile. 

 Rename Rename the Presence button.  

 Delete Delete the Presence button. 

 

Phone Call Types 

 (Gray) Extension is idle 

 (Various colors) Extension is ringing or 'offering' 

 (Various colors) Extension busy (on the phone) 

 Extension is forwarded to another number (internal or external) 

 Forwarded to Voicemail 
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 (Green) Inbound non-queue call 

 (Pink) Outbound non-queue call 

 (Yellow) Inbound queue call (if queuing is installed) 

 (Blue) Outbound queue call (if queuing is installed) 

 

Profiles 

 In the Office 

 In a Meeting 

 Out of the Office 

 On Vacation 

 (Gray Head) Agent is logged in to queues 

 

Voicemail Status 

 No messages 

 1 or more ordinary messages 

 1 or more urgent messages 

 

Select and set your Presence Profile from the: 

 

1. Presence button (right-click), or 

 

 

 

 

 

2. Presence Toolbar. 

 

Your Estimated Time of Return (ETR) can be set for those Presence profiles used when you are not 
available. Selecting one of these profiles will automatically display the ETR window. 

Note: Setting of ETR can be skipped unless ETR is set as 
mandatory in the system settings. 

1. Select your date of return using the calendar function. 

2. Select your approximate time of return using the standard 
times in the left panel or by setting the time using the clock 
function. 

3. Click OK to save the ETR and activate the selected 
Presence Profile. 
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Your own Presence status is indicated in the 
status bar and this information can be viewed by other 
users via your Presence button or from the Phonebook slider. 

You can add a personal Presence note to your Status bar in Desktop, allowing you to communicate 
additional information about your activities and availability to your coworkers. 

1. In the Status Bar, click on the Presence note text <type Presence note here>.  

2. Type in your presence note in the field and press Enter. This Presence note will persist until you 
clear it or enter a new note. 

The Add Presence Page wizard can be used to create either Standard or Dynamic Presence Pages. A 
Dynamic Presence Page lists the contacts for a company or department automatically, while contacts on 
a Standard Presence Page are added and arranged manually. 

Note: Only Users with System Administrator rights can add or edit Global Presence Pages. 

1. To start the Add Presence Page wizard: 

 select Add new Presence Page on the File menu, or 

 right-click in the Presence pane and select Add a new 
Presence Page. 

2. Select the Create Personal Presence Page option.  Only 
administrators can create global pages. 

3. Select the type of page to be created. 

Standard Page Presence buttons must be added and arranged manually. 

Automatic Page Presence buttons are automatically added and updated for the selected 
company/department. 

4. Create Standard page: 
Type a name for your Presence page; go to step 10. 

5. Create Automatic Page: 
Select a company from the listed companies. 

6. Optionally select to list all contacts or only contacts from selected departments. 
Note: This step is only displayed if departments have been defined. 

7. Select the department(s) to display if the department option was selected in step 6 and click Next. 

8. Optionally click the checkbox and specify the number of buttons per page. 
This defines a maximum number of Presence buttons per page and automatically creates an 
additional page when this maximum is reached. 

9. Enter a name for your Presence page and click Next. 

10. Verify the settings and click Finish to create the Presence Page. 

1. Right-click in the Presence page and select Rename this Page from the pop-up menu. 

2. Type in the new name for the page and click OK. 
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1. Open the page you want to delete and right-click on any blank area. Select Delete This Page from 
the pop-up menu.  

2. Click Yes to confirm the deletion when prompted. 

1. Right-click on the Presence page and select the Add a 
Presence button option. 

2. Select either the contact name or the contact number 
and click OK to create a Presence button. 
 
Note: You can also simply drag a contact name or 
number from the phonebook to the Presence page to 
create a Presence button. 

3. Right-click on the Presence button and from the pop-up menu, select Delete. 

 

You can make a phone call from your Executive Insight interface in several ways: 

Using the Phonebook 

1. Click  in the Phone toolbar. 

2. Click  to open the Phonebook. 

3. Locate the contact and select the number to dial, then click the  button, or press Enter. 

Using Presence Buttons or Speed Button 

1. Click the Presence button to make a call using the default number, or 

2. Click the Phone status icon  on the Presence button and click the required number, or 

3. Click a speed button on the Speed toolbar and click one of the numbers. 

1. Click the Answer Call button  on the Phone toolbar, or 

2. Click Answer   on the Phone Calls pane. 
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 Hang up the active call. 

 Place the active call on hold. 

 Park the active call. 

 Transfer the active call. Enter a transfer destination number. 

 Complete the transfer. (Click button or hang up the phone). 

 Cancel the transfer. 

 Swap (Connects you to your original caller, or the transfer destination.) 

 

Record conversation from the active call.  

1. While on an active call, click  and then click the  button to open the phonebook. 

2. Select the contact you wish to transfer the call to from the Found Contacts list. 

3. Select the contact’s number from the Numbers/Addresses list that you wish to transfer the caller to. 

4. Click the Transfer button to transfer the call. 

Note: To assist the transfer stay on the line until the party has picked up, otherwise release the call 
straight away. 

A Voice Message is indicated in the Calls pane by an envelope with a speaker symbol. 

1. Double click the Voice Message in the 
Calls pane, or  
Select Play Message from the right-click 
pop-up menu to listen to the message. 

2. To listen to the message, select either the 

Phone  or Speaker  option and then 

the click the Play button . 

3. While the message is playing, You can: 

 stop the playback  

 adjust the volume  

 rewind, pause or fast forward the message  

4. To save the message as a .wav file on your PC, click Save and use the Save As dialog box to save 
the file. This file can be played back using Windows Media Player or another compatible 
multimedia program. 

file://galactix/ZeacomLibrary/9c65b1a83dad65e4366bcd5c2abc9b29/5.0%20SP2/Subsystems/ExecutiveOutlook/Content/ExecutiveInsight/Using/Record_a_Conversation.htm
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Use the Forward Message option in the right-click popup menu to forward the Voice Message to a 
Mailbox user or a distribution list. 

Note: If you do not check the Keep a copy option, the message will be deleted from your mailbox. 

The Delete Message option in the right-click popup menu is used to delete a voice message. 

Desk-to-Desk chat is used to have a 'conversation' in real time with other internal users by typing text. 

Click on the Chat tab in the Phone bar to open the Chat screen. 

 

 Click to start a new chat call to either a selected chat User or Chat Queue. 

 Click to end the current Chat call. 

 Click to Transfer the current chat call to either a selected Chat User or Chat Queue. 

 
Invite one or more chat users to join the current chat call. Invitees must accept the 
invite to join. 

 Select the chat dialogue and click the Copy button to copy to the clipboard. 

 Save a transcript of the chat conversation in a text format to a specified disk directory. 

 Click to transmit the typed text. Alternatively simply press the keyboard Enter key. 

 Close the current chat pane. 

 Add, edit or delete standard chat phrases or commonly used URL links 
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Select saved text phrases from the drop-down list. These are sent directly to the other 
chat parties. 

 
Select saved URLs from the drop-down list. These are sent as links directly to the 
other chat parties. 

 Push your current Desktop browser URL to the chat recipients. 

 
Automatically send a seies of web page URLs as you navigate using the Desktop web 
browser. The Trace URL button toggles the feature on/off. 

 Pink - Outbound Chat conversation 

 Green - Inbound Chat conversation 

 

1. Click the  button to start a new chat call. 

2. Select either the Chat User or Chat Queue option and then select the specific entry from the drop-
down list. 

3. Click the Chat button in the dialog window. A new conversation pane opens.  

4. Type in the message in the message text field, then click  or simply press the keyboard 
Enter key to transmit the typed text. An outbound chat call will be shown as waiting in the Active 
Calls pane until the recipient answers the call. 

1. Click the  button. 

2. Optionally, click the  button to save a transcript of the chat conversation in a text 
format to a specified disk directory. 

3. Click the  button to close the conversation pane. 

1. When a new chat call pop-up message is displayed: 

 Click Accept on the pop-up message to answer the 
chat call, and then navigate to the Chat pane by 
clicking on the Chat tab, or  

 Click Show Call on the pop-up message to display the  

Chat pane, and then click the  button. 

2. Type in the reply message in the message text field, then click  or simply press the 
keyboard Enter key to transmit the typed text. 

1. Click the  button to transfer the current chat call. 

2. Select a chat User or Queue from the drop-down list. Optionally check the Include current chat 
conversation box to give the recipient access to the prior dialogue.  

3. Click the Transfer button to complete the call transfer. 

1. Click the  button to access the Invite Participants screen. 
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2. Select one or more chat users to join the current chat call.  Optionally check the Include current 
chat conversation box to give the invitees access to the prior dialogue. 

3. Click the Invite button to send the invitations.  Invitees must accept the invite to join. 

When there are three or more chat participants you can have a 
private chat with a selected participant. 

1. Right-click on the participant name and select the Private 
Chat option. 

2. A new chat window opens to enable the private chat session. 

 

Chat Messages provides an organised listing of chat conversations and chat users. Select the required 
category and then use the right-click menu to access the available functions for the selected chat session 
or user. Refer to the online help for more details. 

Templates enable you to save and use commonly used phrases and URLs when chatting. 

Create Template 

1. Click the  button 

2. Choose either the Phrases or Links tab in the Templates dialog window. Existing entries are 
displayed and can be edited or deleted. 

3. Click Add and enter a suitable label and the associated text or URL 

4. Click OK. 

Use Template 

1. Open the drop-down list of either  or  and select the required item from the list. 

2. The text phrase is automatically sent to the other chat parties. The URL is pushed to the other chat 
parties. 

Note: when a URL is received in: 
Desktop – it is shown as an active link and the built-in Web Browser automatically opens the web 
page. 
Executive Insight - it is shown as an active link. 

Refer to the online help for additional less frequently used functions and configuration settings. 
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